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Introduction

Thank you for purchasing the Nikon E2 Browser for Macintosh.
This manual explains how to install the software and how to use it.
Please read this manual thoroughly to ensure a good understanding of its
contents.

Cautions

• The reproduction of all or part of this manual without permission is
prohibited.

• The information contained in this manual is subject to change without
notice.

• We have made every effort to produce an accurate manual, but should
you find any mistakes, we would be grateful if you would kindly let us
know.

• We shall take no responsibility for consequences resulting from the
operation of this product, despite the terms mentioned above.

Introduction

Trademark Information

Apple, Apple logo, Macintosh and QuickTime are registered trademarks of Apple
Computer, Inc.
Adobe and Adobe Photoshop are  trademarks of Adobe Systems Incorporated.
Other brand or product names are the trademarks or registered trademarks of their
respective holders.
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1. E2 Browser Functions

The E2 Browser for Macintosh makes it possible to transfer to Macintosh
computers images recorded on image memory cards using the Nikon E2/
E2s digital still camera.  Images recorded by the E2/E2s can be read using
a PC card drive.
The E2 Browser supports the following functions:
• thumbnail listing of all images stored in an image memory card
• display of image attribute information
• transfer of image files from image memory cards to local disk, where

they can be saved for future reference
• deletion of image files from image memory cards
• multi-display support
• storage of image files
• delivery of selected images to other applications which support

AppleEvents and JPEG and PICT formats (these applications can be
started from within the browser)

• support of uncompressed images

2. Package Contents

The E2 Browser for Macintosh package contains the items listed below.
Check that nothing is missing from your package.  If there are any items
missing, please contact your dealer immediately.
• User's manual (1)
• Install disk (1)

1. E2 Browser Functions
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3. System Requirements

In order to operate the E2 Browser for Macintosh, the following system
environment and software are necessary:

• a Macintosh or Powerbook running System 7.1 and with a 68030 CPU
or greater, or a Power Macintosh running System 7.1.2 or later

• 2MB memory minimum (over 10MB is recommended)
If other applications are to be launched from the browser, there must be
enough free memory to support these applications while the browser is
running.

• 5MB minimum available hard-disk space (over 40MB is recommended)
Note that applications launched from the browser may require addi-
tional working hard-disk space.

• a monitor of 640 x 480 pixels or more and which supports 16.7 million,
64K, 32K, or 256 colors, or 256-shade or 16-shade gray scale (16.7
million colors are recommended)

• a Nikon ED-10 PC card drive
• QuickTime Version 2.0 (included in the install disk)
• Mac-PC Manager (included with the Nikon ED-10 PC card drive)

Note:  When using the E2 Browser, release the card’s write-protection
switch.
Note: If too many images are recorded and there is no space left on
your memory card, E2 Browser cannot display thumbnail images.  In
this case, delete some images before starting E2 Browser.

• an application to which images can be delivered
(any application, such as Adobe Photoshop, which supports AppleEvent
and  JPEG and PICT formats)

3. System Requirements
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4. Installation

Confirm the following items before installing the Nikon E2 Browser
software for Macintosh.

• Protect the Install disk.
• Turn off any virus-checking software.  If this is on, installation may not

complete successfully.  In order to turn off the virus checking software,
first drag the virus checking software out of the Extensions folder and
then restart the Macintosh.

4. Installation
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After confirming the above items, install the Browser as explained in the
following steps.

Step 1
Insert the Install disk into the floppy disk drive and double click the
installer icon.

The following dialog will appear.

4. Installation
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Step 2
Click “Continue…” .  A message dialog will appear; click it.  The Nikon
E2 Browser Installer menu will then appear.

If QuickTime 2.0 has already been installed, choose “Custom Install” from
the pull-down menu near the upper-left corner of the menu to install only
the E2 Browser.  Move to Step 3. (When QuickTime 1.6 or lower has been
installed, you must install QuickTime 2.0 .)

When installing both the E2 Browser and QuickTime 2.0, choose “Easy
Install” from the pull-down menu.  After QuickTime has been installed, it
will be necessary to restart the computer.  The following dialog will appear
when the Install button is clicked.

Click “Continue” to advance to Step 4.

4. Installation
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Step 3
If you choose “Custom Install” in Step 2, the following menu appears.

Check “Nikon E2 Browser” and click “Install”.  Only the E2 Browser will
be installed.

Step 4
You can select a folder for installation by choosing “Select Folder…” from
the pull-down menu in the Install Location box.

4. Installation
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The folder menu appears.

Select a folder and click “Install” to start the installation.  The
following message is displayed during the installation process.

4. Installation
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Step 5
When the installation finishes normally, one of the following messages will
be displayed.

When you did not install QuickTime 2.0:

Click “Quit” to finish the installation.

When you have installed QuickTime 2.0:

Click “Restart” to restart the Macintosh.

4. Installation
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Step 6
After the installation has been completed, click the E2 Browser icon once
to select it and then choose “Get Info” from the File menu.

If possible, enter the value equal to or greater than the “Suggested size” in
the “Preferred size” text box.  If the memory allocated is less than the
suggested value, the E2 Browser will not be able to support non-com-
pressed images or the PICT format.

4. Installation
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5. Main Dialog Box

5.1 Starting-up the Browser
Double-click the E2 Browser icon to start the browser.  The Main dialog
box will appear.
When you first start the E2 Browser after installation, thumbnail images
will not be displayed.  Refer to Section 6.1 for information on selecting an
image folder to be displayed.

5.  Main Dialog Box

Icon buttons

Nikon logo Total number

of images

Title bar

Menu bar

Scroll barThumbnail images

Month/Day  Hour/Minute/Second
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The maximum number of images which can be displayed in the window at
one time depends on the size of the monitor.  If the monitor is larger than
800 x 600 pixels, up to 30 thumbnail images can be displayed.  Otherwise,
a maximum 20 thumbnail images can be displayed.

5.2 Selecting images
Click a thumbnail image once to select it.
To cancel the selection, click the selected thumbnail image again while
pressing the shift key, or click another thumbnail image.
To select two or more thumbnail images, click each image in succession
while pressing the shift key.
To select all thumbnail images, pull down the Edit menu and choose
“Select All”.

5.3 Quitting the Browser
To quit the E2 Browser, pull down the File menu to select “Quit” or click
the close box in the Main dialog.

5.  Main Dialog Box
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5.4 Main dialog functions

Title bar: Drag the title bar to move the dialog box.
Click the close box on the left end of the title
bar to quit the Browser.

Icon buttons: The icon buttons can be used to access most
Browser functions.

Total number of images: Displays the total number of files in the
selected folder.

Thumbnail images: Displays thumbnail previews of image files
recorded using the Nikon E2/E2s digital still
camera.  Depending on the size of the monitor,
up to 20 or 30 images are displayed at one time
from left to right and top to bottom in the order
recorded.  If the monitor is larger than 800 x
600 pixels, 30 images can be displayed.
Otherwise, 20 images can be displayed. (Up to
999 thumbnail images can be displayed in one
folder.)

Date and Time: Gives the date (Month/Day) and time
(Hour:Minute:Second)  the file was created.

Scroll bar: When all files cannot be displayed at one time,
click the scroll bar or arrow buttons to view the
remaining thumbnails.

Nikon logo: Clicking the Nikon logo displays the About
dialog.  The About dialog gives a list of icon
buttons together with a brief description of
their functions.

5.  Main Dialog Box
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5.5 Icon buttons
The icon buttons are listed below, together with their functions.  Click the
icon button once to perform the associated operation.

Updates the thumbnail images in the Main dialog box.

Click this button to specify how images will be saved
and what application will be used to open image files.

Gives the attribute information for selected images.

Deletes selected images.

Saves selected images.

Click this button to choose the image folder to be
displayed in the Main dialog box.

 Source folder icon

Duplicate icon

Delete icon

Information icon

Click this button to open selected images in another
application.

Open with.. icon

Preferences icon

Refresh thumbnail icon

5.  Main Dialog Box



Nikon   E2 Browser for Macintosh User's Manual14

displayed on the desktop.  Check to be sure that the write-protect switch is
off before inserting the card in the drive.

6.1 Displaying images
This section explains how to select the folder containing the images to be
displayed.

Pull down the File menu to select “Change Folder …” or click the Source
folder icon in the Main dialog box.  The Folder dialog will be displayed.

6. E2 Browser Operation

Browser functions can be performed using the menus
or icon buttons.  Before starting the E2 browser, insert
the memory card containing the image files in the PC
card drive and make sure that the PC memory icon is

6. E2 Browser Operation

 Source folder icon

Select button

Folder menu
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Select a folder a folder containing image files from the Folder menu and
click the Select button.  Once a folder has been selected, thumbnail pre-
views of the files in the folder will be displayed in the Main dialog box.

Folder dialog buttons:

“Eject” Ejects removable disk media.

“Desktop” Click this button to view the contents of the
desktop folder.

“Cancel” Closes the Folder dialog without changing
folders.

“Open” Opens the selected folder.

6.2 Saving images
This section explains how to save selected images to a local disk.

Select images to be saved from the Main dialog box, then pull down the
File menu to select “Save…” or click the Duplicate icon in the Main dialog
box.  The Save dialog will be displayed.
If two or more thumbnail images are selected, the Browser saves the
images in the order recorded.
How files will be named and stored depends on the settings in the Prefer-
ences dialog box (see 6.6, “Preferences”).  The contents of the Save dialog
will differ depending on whether the naming method is “Automatic,” “No
change,” or “Manual.”  To choose a naming method, click “Preferences” in
the Save dialog box.

6. E2 Browser Operation

Duplicate icon
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The Save dialog when “Automatic” or “No change” has been chosen
as the naming method:

The Save dialog when “Manual” has been chosen as the naming
method:

Click “Preferences” to bring up the Preferences dialog, which offers a
choice of file formats and naming methods (see 6.6, “Preferences”).
When the naming method is “Manual,” the image will be saved under the
name entered in the “File name” text box.  If “Automatic” has been chosen
the file will be saved under a computer-generated name, while choosing
“No change” results in the file being saved under the name assigned by the
E2/E2s.

6. E2 Browser Operation
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After selecting a folder and, if necessary, specifying a file name, click
“Save” to save all selected images (“Automatic” or “No change”) or the
image currently displayed in the Save dialog’s preview window (“Manual”).

Save dialog buttons:

“Eject” Ejects removable disk media.

“Desktop” Click this button to view the contents of the
desktop folder.

“New folder” Creates a new folder.

“Cancel” Cancels the operation.

“Save” Saves the selected images.

“Skip” When the naming method is “Manual,” this
button will be displayed to allow you to pass
over the current image without saving it.

6.3 Deleting images
This section explains how to delete selected images.

Select images to be deleted from the Main dialog box, then pull down the
Edit menu to select “Delete…” or click the Delete icon in the Main dialog
box.  The Delete dialog will be displayed.

Delete icon

6. E2 Browser Operation
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If two or more thumbnails are selected, the Browser will delete the files in
the order recorded.

Note: Files deleted using this function are not sent to the Trash and
cannot be recovered.

Delete dialog buttons:

“Delete” Deletes the image currently previewed in the
Delete dialog box.

“Cancel” Returns you to the Main dialog box without
deleting further images.  Images that had
already been deleted before the “Cancel”
button was pressed will not be restored.

“Skip” When two or more items remain to be deleted,
clicking “Skip” allows you to move to the next
item without deleting the image currently
previewed in the Delete dialog box.

“Delete all” Deletes all selected images.

6. E2 Browser Operation
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6.4 Attribute information
Attribute information for each image is recorded on the E2/E2s PC memory
card.  This section explains how to display the attribute information for
selected images.

In the Main dialog box, select the images for which you want attribute
information.  Then select “Attribute information…” from the Browser
menu or click the Information icon in the Main dialog box.  The Attribute
Information dialog will be displayed.
When two or more images are selected, the Browser will display the
attribute information for each image in succession, starting from the
earliest image and continuing in the order the images were recorded.

The Attribute Information dialog gives the file name and date and time of
recording, as well as the image quality (HI/FINE/NORMAL/BASIC),
shutter speed, and aperture settings used to record the image.

6. E2 Browser Operation

Information icon
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6. E2 Browser Operation

Attribute Information dialog buttons:

“Next image” Clicking this button displays the attribute
information for the next image selected.

“Exit” Closes the Attribute Information dialog and
returns you to the Main dialog box.

6.5 Delivering images to other applications
Selected images can be delivered to an application such as Adobe
Photoshop which supports AppleEvent and JPEG and PICT formats.  If the
application is not running at the time the images are delivered, it will be
launched automatically.  The destination application for this operation is
set through the Preferences dialog (see 6.6, “Preferences”).

In the Main dialog box, select the images to be delivered to the other
application.  Pull down the Browser menu to select “Deliver Images” or
click the Open with… icon in the Main dialog box.  Copies of the selected
images will then be opened in the destination application.
So that the original image files will not be affected, the Browser saves
copies of the images to a folder named “To name of application” and
located in the E2Browser folder.  The file names will be those of the
original images with the first two letters replaced by “AP”.  Compressed
images (i.e., images recorded at an image setting of BASIC, NORMAL, or
FINE) will be stored in JPEG format (the same as that used on the memory
card), while uncompressed (HI image quality) images will be stored in the
PICT format.  These copies remain as back-ups after the destination
application has closed and must be deleted manually when no longer
needed.

Open with… icon
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6.6 Preferences
The Preferences dialog box allows you to select the naming method and
file format used when files are saved, and to specify the application to
which images will be delivered.

Pull down the File menu to select “Preferences… ” or click the Preferences
icon in the Main dialog box.  The Preferences dialog will be displayed.
The Preferences dialog can also be displayed by clicking the “Preferences”
button in the Save dialog box.

6. E2 Browser Operation

Preferences  icon
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Items in the Preferences dialog box :

How to decide file name: Specifies method used to name files.  The
following options can be chosen from the pop-
up menu:

Automatic: A name is automatically assigned according to the

computer’s internal clock calendar and the format

(JPG/TIF/PICT) in use at the time the file is saved.

No change: Files are saved under the name assigned by the E2/

E2s when the image was originally recorded.

Manual: A user-specified file name is used.

Image mode “HI” Storing method:
Specifies the format to be used when saving
uncompressed images.  The associated pop-up
menu offers a choice of “No conversion”
(TIFF) or “PICT”.

Image mode BASIC/NORMAL/FINE Storing method:
Specifies the format for compressed images.
The associated pop-up menu offers a choice of
“No conversion” (JPEG) or “PICT”.

Preferences dialog buttons :

“Cancel” Cancels any changes to preferences and closes
the Preferences dialog box.

“OK” Updates the preferences and closes the Prefer-
ences dialog box.

“Select application …” Opens the Application Selection dialog box
(shown opposite) from which a destination
application can be chosen (this is the applica-
tion that will open when the Open with… icon
is clicked or “Deliver Image” is chosen from
the Browser menu).  This option is not avail-
able when the Preferences dialog has been
opened from the Save dialog box.

6. E2 Browser Operation
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Application selection menu

Navigate to the folder containing the destination application using the
Folder menu, then select the desired application from the files in the list
box and click the Select button.  The Application Selection dialog will
close, causing the Preferences dialog to be displayed once more.

Function of each button:

“Eject” Ejects removable disk media.

“Desktop” Click this button to view the contents of the
desktop folder.

“Cancel” Closes the Application Selection dialog
without changing the destination application.

“Open” Opens the selected folder.

Preferences are stored in the “E2 Browser Prefs” file in the Preferences
folder, which in turn may be found in the System Folder.  The settings in
this file are used when the Browser is launched.

Folder menu

Select button

6. E2 Browser Operation
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6.7 Refreshing the thumbnail images

Updates the thumbnail previews in the Main dialog box.

To update the display, pull down the Browser menu to select “Refresh” or
click the Refresh thumbnail icon in the Main dialog box.

6.8 About dialog

The About dialog can be displayed by selecting “About Nikon E2 Browser…”
from the Apple menu or clicking the Nikon logo in the Main dialog box.

Refresh thumbnail icon

6. E2 Browser Operation
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7. Troubleshooting

When an error occurs, one of the following error messages will be dis-
played.  Take the action prescribed in the message or in the table below.

Message: An unexpected error has occurred.  Operation cannot
continue.  The E2 Browser will quit.  Contact Nikon
Technical Support.

Message: The folder contents will be read and displayed, but the
selected media is write-protected.  Operation cannot
continue.

Action: Unlock the file or release the media’s write-protection tab.

Message: The disk drive does not have enough available space to
save files.

Action: Increase space on the hard disk by erasing unnecessary files.

Message: The disk drive is locked and the selected files cannot be
saved.

Action: Release the media’s write protection tab.

Message: Operation cannot continue because file is damaged.

Action: Confirm whether the selected file exists or not.

Message: Operation cannot continue because there is insufficient
memory.  The E2 Browser will quit.

Action: Increase the amount of memory available to the E2 Browser
following the steps given on page 9 of this manual.

7. Troubleshooting
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Message: Due to changes in the environment, operation cannot
continue.  The E2 Browser will quit.  The E2 Browser
needs System 7.1 and QuickTime 2.0 or a later ver-
sions.

Action: The E2 Browser needs System 7.1 or higher and QuickTime
2.0.  Confirm that you have satisfied the system requirements
given in 3, “System Requirements”.

Message: Operation cannot continue because an error occurred
when the image delivery application was launched.

Action: Increase the amount of memory available to the E2 Browser
or the application to which images are to be delivered.

7. Troubleshooting
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